A Principled Technologies report: Hands-on testing. Real-world result

Dell XC series solutions powered by Nutanix can boost
datacenter efficiency

when combining workloads on a hyperconverged Dell™ XC series solution
with Nutanix® Acropolis™ and Prism

Upgrading to a new hyperconverged solution can help you save
space and improve efficiency in your datacenter. Choosing the right
new solution can be challenging, however. You need something that
will successfully handle your current resource needs while leaving
you plenty of room to grow.
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At Principled Technologies, we compared two different datacenter
solutions: a bare-metal legacy solution consisting of 5- to 7-year- = = =
old components and a brand-new hyperconverged solution = = -
featuring three Dell XC730xd-12 appliances with Intel® Xeon® = = =
processors E5-2680 v4, running Nutanix Acropolis and Nutanix = = )=
Prism management software. ;: ;: ;:
Though both solutions ran a mixed workload of database, email, ;: ;: ;:
and simulated file server work, the new Dell XC series solution did = - -
eight times the work of the 8U legacy one. When we added a fourth = = =
appliance, the hyperconverged solution did ten times the work of = = )=

the legacy solution. — — =

This Dell XC series solution doesn’t require external storage. Do the work of 10
By ugrading to it, you could reduce rack space by getting rid of )
external storage arrays entirely, potentially simplifying hardware Iegacy solutions
configuration and maintenance.

We ran the Dell Performance Analysis Collection Kit (DPACK) to gather information on
the performance of the new environment. By running DPACK in your own datacenter,
you can characterize your environment's performance and resource utilization, plus
identify bottlenecks for troubleshooting. Then, take a look at the DPACK data for
our newer solution to see its performance metrics. In your environment, using
DPACK can highlight upgrade opportunities and help you better understand
specific performance requirements.
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Save space and do more when you upgrade

The growing problems with legacy hardware

As your legacy infrastructure gets older, it may not be able to keep up with the growth of business. Consider the
following obstacles:

1. Customers are always demanding new innovations and a consistent quality of service. When you're relying on
aging, slowing hardware, those things can be hard to provide.

2. Between normal wear and tear and updates, IT administrators have to spend more time maintaining
legacy hardware.

3. Even when it can handle your current performance needs, legacy hardware lacks the speed of newer processors,
functionality of newer management features, and benefits from other new technologies.

4. Constantly expanding with repurposed hardware to handle your customers’ needs contributes to costly
datacenter sprawl.

Upgrading to a Dell XC series hyperconverged solution powered by Nutanix can help overcome these obstacles.

Scale simply as your business grows
Scaling a Dell XC series solution with more hardware is straightforward — simply add another node.

The addition of a fourth Dell XC730xd-12 node increased the size of our solution by only 2U. This scaling up immediately
paid off by delivering more compute, networking, and storage resources, boosting the amount of work the new solution
can do. The scaled Dell XC with Nutanix solution did 10 times the work of the legacy solution.

Every business wants to reach its full potential and needs its datacenter to support continued growth. Scaling the Dell XC
series solution could handle that growth with ease.

Reap the benefits of a hyperconverged solution

When you virtualize with the Dell and Nutanix solution, you

consolidate your workloads and save space by removing the
need for a physical storage array.

Moving to a fully virtualized, hyperconverged solution

has several other advantages, however. Virtualization lets

the solution run multiple, separate workloads in a single
appliance. The virtualized workloads use only the portions of
the physical resource allotted to them. If a VM maxes out one
resource, the other VMs can still use their portion.

This means it's less likely that idle physical resources will go
underutilized while other resources bottleneck, a common
problem in legacy hardware. In a traditional legacy setup,

IT may assign a single application to a single server. That
application uses the hardware resources it needs while
others sit idle. This problem grows with the company; as the
organization splits into multiple departments with distributed
IT staff, it can get even worse.

Nutanix Acropolis can leverage the compute, storage, and

A hyperconverged solution features a software-
based architecture that closely integrates
virtualization, compute, storage, and networking
resources in a single appliance, which you can
scale modularly for high availability and additional
performance. IT can typically manage the
resources from a single interface.

The market for hyperconverged systems like

the Dell XC series solution is growing quickly, as
Gartner analysts predict they “will be mainstream”
in the next five years.

networking resources in the Dell XC730xd-12 nodes to increase existing application efficiency and gain maximum
performance benefits. What's more, leftover compute, storage, and networking resources are available to do things like

power new applications or expand existing ones.
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Keep your favorite management tools

Dell Open Manage Essentials

The hyperconverged Dell XC series solution offers
new technologies, but that doesn’t mean you have to
retool your management software. Both of the solutions
we tested support Dell OpenManage Essentials
o (OME), management software you may already use

in your own legacy Dell environment. If you upgrade
to the hyperconverged solution, you can keep using
this familiar Dell tool and not re-train your IT staff on
new management software. In previous studies, we
found OME can save time and improve efficiency in
datacenter management.”

Moreover, Dell OME has evolved and improved in the
time that has passed since our legacy environment was
new. You'll be able to leverage the same toolset you
already know, but you'll also gain access to additional
and upgraded features.

Run more mixed workloads in less space

In our datacenter, we determined that by upgrading
from a legacy environment to one with the new Dell XC
series hyperconverged solution, you can do eight times
more work in 2U less rack space. That can translate to
consolidating workloads from multiple departments.

By reclaiming rack space (up to 1 ' racks, or 58U, in this
scenario), you can ease any immediate concerns about
the need to expand your datacenter. Consolidating
workloads opens newly available rack space and existing
hardware for continued growth, and it can offer potential
savings on your monthly power and cooling bills. Less
hardware means less to manage too, which can save
valuable IT administrator time.

Dell Performance Analysis Collection Kit

Take a look at DPACK s

DPACK measures the throughput, disk /0, memory,
capacity, and CPU utilization of your servers and storage.
Its reports present this data to help you better understand
what hardware you'll need when you upgrade.

Using the DPACK online viewer, you can review your
results in two ways: Aggregate or Individual. Aggregate
results offer performance data for the full environment,
while Individual results provide numbers for just a single
specific server. When we ran DPACK on the new Dell and
Nutanix solution, we viewed Aggregate results.

In addition to simply running DPACK in your own
environment, you can contact a Dell salesperson who can
help you interpret your DPACK results, size your upgraded
environment, and choose a solution that best fits your
needs. We did not test this service. e
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Our roadmap to an upgraded infrastructure

Our legacy environment

We created our legacy solution to approximate an infrastructure that a small enterprise
might have purchased five or six years ago and still use today. This bare-metal (non-
virtualized) environment contained three Dell PowerEdge R710 servers with one Dell
EqualLogic™ PS6110 storage array. Appendix A has complete details on the solution.

Our upgraded environment

Our upgraded environment represents a possible next step for an enterprise moving from
the legacy environment we chose.

The Dell hyperconverged solution contained three Dell XC730xd-12 nodes with a fourth for scaling, all powered by
Intel Xeon E5-2680 v4 processors. See Appendix A for more details. We installed Nutanix Acropolis hypervisor (version
20160217) on the nodes and then added the Nutanix Prism management software (version 4.6.1.1). Nutanix Prism gives
administrators a centralized management tool for their Acropolis virtual environments. It provides tools to manage
clusters, VMs, and storage as well as performance monitors for troubleshooting and real-time visibility into the health of
the environment. Additionally, Prism streamlines updates for hypervisor, management software, and firmware through
automated processes that minimize downtime and administrator interaction.

Nutanix Prism management software
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What we did

On the legacy environment, we ran multiple iterations of the same mixed workload. The workload contained database,
email, and simulated file server applications with a dedicated server for each. We tuned each application to its maximum
performance while maintaining acceptable thresholds for storage latency—a measure of how fast storage can complete a
request. For our purposes, those thresholds were under 20ms.

Then, on the new Dell and Nutanix environment, we virtualized all legacy application servers and multiplied these VMs
and their workloads in sets until we reached a bottleneck (CPU, storage capacity, or storage latency). In our case, the
bottleneck was storage latency, with average latency once again getting close to 20ms with eight sets of the workloads.

After we tested with three appliances, we scaled up by adding a fourth appliance to the solution and tested again,
reaching a storage latency bottleneck after 10 sets of the workloads.

To capture data on the upgraded environment's performance, we ran DPACK. (For our DPACK results on both solutions,
view Appendix D.)

A Dell and Nutanix solution can boost datacenter efficiency August 2016 | 4



Our workloads

We generated the workloads for each application using industry-standard
tools. For a database, we chose Microsoft® SQL Server® 2014 running

a DVD Store 2 workload; for email, we chose Microsoft Exchange 2013
running a Microsoft Exchange Load Generator 2013 workload; and for file/
print, we chose the lometer tool, which generates synthetic data streams
mimicking a file server workload. This mixed workload reflects many
companies’ operations.

Conclusion

Continuing to run a legacy infrastructure may be possible, but it isn't
optimal—not when new technologies like the Dell and Nutanix solution are
available. By upgrading to this new hyperconverged infrastructure, you could
do eight times the work of a legacy solution in just 6U and scale for more

work by simply adding another node. What's more, eliminating the need for
centralized SAN storage means more space to grow, less hardware to manage,
and the potential for lower power and cooling bills.

Take the first step on the path to an upgraded environment. Run DPACK
in your own datacenter, and discover your performance requirements and
potential bottlenecks. Then consider how the increased mixed workload
performance from the hyperconverged, Intel processor-powered Dell and
Nutanix solution could help your business thrive.

1 http://www.gartner.com/newsroom/id/3308017

2 See the Principled Technologies reports Systems management savings with Dell
OpenManage on 13G Dell PowerEdge servers and Dell OpenManage Essentials:
Improve efficiency with fewer tools, more benefits.

http://en.community.dell.com/techcenter/extras/w/wiki/dvd-store
https://www.microsoft.com/en-us/download/details.aspx?id=14060

http://www.iometer.org/

J L

DVD Store 2

We used DVD Store Version 2.1,

or DS2.° DS2 is a performance
measurement tool that works as a
sample SQL Server workload. It models
an online store where customers log

in, search for products, and make
purchases. It also performs other
actions, such as adding new customers,
to exercise a wide range of everyday
database functions.

Microsoft Exchange Load
Generator 2013

Microsoft Exchange Server is an email
application that businesses use widely
across multiple industries. To test
how well the solutions could run an
Exchange server workload, we used
Microsoft Exchange Load Generator
2013 (LoadGen), which functions as

a sample Exchange workload and
simulates a large number of users
generating email activity.*

010
010

lometer

Your employees likely use file/print
servers often, so we simulated a
file/print workload using lometer

1.1.° lometer uses action profiles to
perform input/output (I/O) operations
that can mimic specific types of data
streams, such as the kind that occur
when employees upload, download, or
search for files or print documents on

a host server.
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On May 28, 2016, we finalized the hardware and software configurations we tested. Updates for current and recently
released hardware and software appear often, so unavoidably these configurations may not represent the latest versions
available when this report appears. For older systems, we chose configurations representative of typical purchases of
those systems. We concluded hands-on testing on June 10, 2016.

Appendix A — Test systems

Hardware configuration information 3x Dell PowerEdge R710 4x Dell XC730xd-12

BIOS name and version

Non-default BIOS settings

Operating system name and version/

build number

Date of last OS updates/patches

Dell 6.4.0

N/A

Windows Server® 2012 R2

Dell 2.0.2
N/A

Acropolis Hypervisor Nutanix
20160217

applied 03/31/16 05/28/16
Power management policy Balanced Performance
Processor

Number of processors 2 2

Vendor and model

Intel Xeon E5520

Intel Xeon E5-2680 v4

Core count (per processor) 4 14
Core frequency (GHz) 2.26 2.4
Stepping DO MO
Memory module(s)

Total memory in system (GB) 48 256
Number of memory modules 6 16

Vendor and model

Samsung M393B1K70DHO-YH?

Micron MTA36ASF2G72PZ-
2G1A2IK

Size (GB) 8 16

Type PC3-10600 PC4-2133P
Speed (MHz) 1333 2133
Speed running in the server (MHz) 1333 2133
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Storage controller
Vendor and model
Cache size

Firmware version

Driver version

Local storage

Number of drives

Drive vendor and model

Drive size (GB)

Drive information (speed, interface,

type)

Local storage 2
Number of drives

Drive vendor and model

Drive size (GB)

Drive information (speed, interface,

type)

Network adapter

Vendor and model
Number and type of ports
Driver version

Network adapter 2
Vendor and model
Number and type of ports

Driver version

Dell PERC 6/i
256MB
6.3.3.0002

6.600.21.8

2
Western Digital WD3000BKHG

300

10K, 6Gb SAS, 2.5” HDD

N/A
N/A

N/A

N/A

Broadcom BCM5709C
4 x 1GbE

7.4.23.2

Intel Ethernet Server Adapter X520

2 x 10GbE

3.9.58.9101

Hardware configuration information 3x Dell PowerEdge R710 4x Dell XC730xd-12

Dell HBA 330 Mini
None
9.17.20.07

N/A

4
Intel SSD DC S3710

400

SATA, 6Gbps, 3.5”SSD

Seagate ST4000NMO005

4000

7.2K, SAS 12Gbps, 3.5 HDD

Intel X520/1350 rNDC
2 x 1GbE, 2 x 10GbE

ixgbe 4.0.1-k-rh7.1

N/A
N/A

N/A
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Hardware configuration information 3x Dell PowerEdge R710 4x Dell XC730xd-12

Power supplies

Vendor and model Dell N870P-S0O Dell D1100E-SO
Number of power supplies 2 2
Wattage of each (W) 870 1100

The figure below provides detailed configuration information for the legacy storage solution.

Storage configuration information Dell EqualLogic PS6110

Controller firmware revision V7.0.5 (R390599)

Number of storage controller 2 x 70-0477 (TYPE 14)

modules

Number of drives 24

Drive vendor and model number Seagate® ST9900805SS
Drive size (GB) 900

Drive information (speed, interface,

10K, 6Gb SAS, HDD
type)
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Appendix B — How we tested

Legacy environment

We used the following steps to configure our legacy Dell PowerEdge R710 mixed workload environment. We included
notes on the virtual disk settings where applicable because we also used these steps in the creation of the upgraded
environment's virtual machine.

Performing the initial OS install and setup

Installing Windows Server 2012 R2

Insert the installation media into the CD/DVD drive, and restart the server.

When prompted to boot from DVD, press any key.

When the installation screen appears, click My language is English (United States).
Leave language, time/currency format, and input method as default, and click Next.
Click Install now.

When the installation prompts you, enter the product key.

Select Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.

Check | accept the license terms, and click Next.

®© N ok wnNh =

9. Click Custom: Install Windows only (advanced).
10. Select Drive 0 Unallocated Space, and click Next.
11. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.

12. Log in with the password you set up previously.

Configuring the operating system
1. Enable remote desktop access.
2. Change the hostname, and reboot when the installer prompts you.
3. Set up networking:
a. Click Start>Control Panel, right-click Network Connections, and select Open.
b. Right-click the management traffic NIC, and select Properties.
c. Select TCP/IP (v4), and select Properties.
d. Setthe IP address and subnet for the NIC, which will handle management traffic, and click OK.
e. Click OK, and click Close.

4. Install all available Windows updates. Restart as necessary.

Configuring the Microsoft Active Directory and lometer server

For the legacy environment, we created a large dedicated LUN on the Dell EqualLogic PS6110 storage for the lometer
workload file. For the upgraded environment, we added a 120GB virtual disk for lometer to the AD VM using the default
Nutanix storage pool.

Installing Active Directory and DNS services
Launch Server Manager.

Click Manage>Add Roles and Features.
At the Before you begin screen, click Next.

At the Select installation type screen, leave Role-based or feature-based installation selected, and click Next.

ok wnh =

At the Server Selection Screen, select the server from the pool, and click Next.
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6. At the Select Server Roles screen, select Active Directory Domain Services. When prompted, click Add Features, and
click Next.

At the Select Features screen, click Next.
At the Active Directory Domain Services screen, click Next.

At the Confirm installation selections screen, check Restart the destination server automatically if required, and
click Install.

Configuring Active Directory and DNS services

1. After the installation completes, a screen should pop up with configuration options. If it does not, click the Tasks flag in
the upper-right section of Server Manager.

2. Click Promote this server to a Domain Controller.

w

At the Deployment Configuration screen, select Add a new forest. In the Root domain name field, type
test.local, and click Next.

At the Domain Controller Options screen, leave the default values, and enter a password twice.
To accept default settings for DNS, NetBIOS, and directory paths, click Next four times.

At the Review Options screen, click Next.

A

At the Prerequisites Check dialog, allow the check to complete. If there are no relevant errors, check Restart the
destination server automatically if required, and click Install.

8. When the server restarts, log on using test\Administrator and the specified password.

Configuring the Windows Time Service on the domain controller
To ensure reliable time, we pointed our Active Directory server to a local NTP server.

1. Open a command prompt.
2. Type the following:
W32tm /config /syncfromflags:manual /manualpeerlist:”<ip address of a NTP server>”
W32tm /config /reliable:yes
W32tm /config /update
W32tm /resync
Net stop w32time

Net start w32time

Preparing AD for Microsoft Exchange

1. Create a reverse lookup zone:

a. Click the start button, and in the search field, type DNS.

b. Open the DNS manager by clicking on it in the results field.

c. Expand your Active Directory domain, and click Reverse Lookup Zones.
d. Click Action>New Zone.

e. On the Welcome screen, click Next.

f.  Chose Primary Zone, and click Next.

g. Leave default replication scope, and click Next.

h. Choose IPv4, and click Next.

i. Enter the IP address of your domain (192.168.1 for our example).

A Dell and Nutanix solution can boost datacenter efficiency August 2016 | 10



j. Choose Allow both nonsecure and secure dynamic updates, and click Next.
k. Click Finish.

Insert the Exchange 2013 R2 Installation ISO in the AD DVD drive.

In Windows Explorer, double-click the Exchange DVD icon.

In the Exchange installation folder, hold down shift, and right-click.

Choose Open a command window here.

Run the following command: Setup.exe /PrepareSchema /IAcceptExchangeServerLicenseTerms

No ok~ wbd

When the previous command completes, run the following command: Setup.exe /PrepareAD /
OrganizationName:”organization name” /IAcceptExchangeServerLicenseTerms

8. When the setup finishes, close the command window.

Installing Active Directory Certificate Services

Launch Server Manager, and select Add roles and features.

At the Add Roles and Features Wizard, click Next.

Select Role-based or feature-based installation, and click Next.
Choose Active Directory Certificate Services.

Click Add Features, if prompted, to install any required features.
Click Next three times.

Choose Certificate Authority and Certification Authority Web Enroliment.

© N o bk wDNh =

Click Add Features, if prompted, to install any required features.
Click Next.

. Leave defaults, and click Next.

. Click Install.

. When the install finishes, click Close.

_ e a0
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. Click the yellow warning symbol in the Server Manager, and click Configure Active Directory Certificate Services.

—
o

. Leave defaults, and click Next.
. Check both Certification Authority and Certification Authority Web Enrollment, and click Next.

—_
o~ »

. Choose Enterprise CA, and click Next.
. Choose Root CA, and click Next.

. Choose Create a new private key, and click Next.

—_
O 00

. Leave defaults, and click Next.

N
(@]

. Leave defaults, and click Next.

N
—_

. Leave 5 years, and click Next.

N
N

. Leave default locations, and click Next.

N
w

. Click Configure.

N
~

. When the configuration finishes, close the window.

N
(&,

. Open Internet Explorer®, and navigate to localhost/certsrv/Default.asp to verify that the
installation succeeded.

Installing lometer

1. Download the lometer 1.1.0 package for Windows from www.iometer.org/doc/downloads.html.
2. Double-click the installer, and click Run.

3. At the Welcome window, click Next.
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At the License Agreement window, click | Agree.
At the Choose Components window, leave the defaults selected, and click Next.

At the Choose Install Location window, leave it at defaults, and click Install.

A

When the installation is complete, click Finish.

Setting up the lometer workload
We used the following settings for each test:

1. Open lometer.exe.

2. Create the following access specification:

Transfer Delay: Oms

Burst Length: 1 1/0

QOutstanding 1/Os: 1

Under Reply Size, select No Reply.

100% random

80% reads

g. Under Align 1/Os, select Sector Boundaries.

o o

- 0o a 0

Under Disk Targets, set the number of Outstanding I/Os to 1.
Set the disk size to 209715200 (100 GB).
Under Results Display, make sure that lometer has selected Start of Test.

Under Test Setup, set the Run Time to 60 minutes and the Ramp Up Time to 600 seconds.

N o ook w

Exit lometer.

Configuring the Microsoft Exchange 2013 Server

Joining the domain

Set a static IP.

Select Start-> Control Panel>Network Connections=>Local Area Connection.
Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.

ok w =

Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the Preferred
DNS server field. Click OK.

Right-click My Computer, and select Properties.
Under the Computer Name tab, click Change.

In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and type
test.local

9. To start joining the domain, select OK.

10. When the screen appears asking for a person qualified on the domain, type Administrator as the username and
Passwordl as the password.

11. At the Welcome pop-up window and the window warning that you must reset the computer for the changes to take
effect, click OK.

12. At the System Properties screen, click OK.

13. When a pop-up appears asking if you want to restart now, to restart your computer, click Yes.
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Installing Exchange Server 2013 SP1 Mailbox and Client Access Server roles

For the legacy environment, we created large dedicated LUNs on the Dell EqualLogic PS6110 for the Exchange
database, logs, and backup. For the upgraded environment, we added a 120GB virtual disk for the database, a 10GB
virtual disk for logs, and a 120GB virtual disk for backup to the Exchange VM using the default Nutanix storage pool.

1. On the Exchange Server, log into the server using domain administrator credentials.
2. Open Windows PowerShell®, and run the following command:

Install-WindowsFeature AS-HTTP-Activation, Desktop-Experience, NET-Framework-45-
Features, RPC-over-HTTP-proxy, RSAT-Clustering, RSAT-Clustering-CmdInterface,
RSAT-Clustering-Mgmt, RSAT-Clustering-PowerShell, Web-Mgmt-Console, WAS-
Process-Model, Web-Asp-Netd5, Web-Basic-Auth, Web-Client-Auth, Web-Digest-

Auth, Web-Dir-Browsing, Web-Dyn-Compression, Web-Http-Errors, Web-Http-Logging,
Web-Http-Redirect, Web-Http-Tracing, Web-ISAPI-Ext, Web-ISAPI-Filter, Web-Lgcy-
Mgmt-Console, Web-Metabase, Web-Mgmt-Console, Web-Mgmt-Service, Web-Net-Ext45,
Web-Request-Monitor, Web-Server, Web-Stat-Compression, Web-Static-Content, Web-
Windows-Auth, Web-WMI, Windows-Identity-Foundation

3. Restart the server.

4. Download the Microsoft Unified Communications Managed API 4.0, Core Runtime 64-bit (go.microsoft.com/fwlink/
p/?linkld=258269).

5. Run UcmaRuntimeSetup.exe.

6. When the installation completes, click Finish.

7. Navigate to the location of the Exchange installation media, and double-click Setup.exe.

8. At the Check for Updates? screen, check the Connect to the Internet and check for updates checkbox, and

click Next.
9. When the updates complete, click Next.
10. At the Introduction screen, click Next.
11. At the License Agreement screen, check to accept the terms, and click Next.
12. At the Recommended Settings screen, check Don't use recommended settings, and click Next.
13. At the Server Role Selection, select Mailbox and Client Access role, and click Next.
14. At the Installation Space and Location screen, leave the default location for the installation, and click Next.
15. To disable the Malware Protection Settings, select Yes, and click Next.
16. At the Readiness Checks screen, allow the verification to complete. If there are no failures, click Install.

17. When the installation completes, click Finish, and restart the server.

Configuring Exchange

1. On the Exchange server, open the Exchange Admin Center by using a browser and navigating to https://
localhost/ecp

Enter the domain administrator credentials, and click Sign in.

If prompted, select the language and time zone, and click Save.

In the left pane, click Mail Flow, and then click Send Connectors.

On the Send Connectors page, click the New icon.

In the New Send Connector wizard, specify SMTP as the name, and select Internet as the type. Click Next.
In the Network settings screen, choose MX record associated with recipient domain, and click Next.

In the Address space screen, click the Add icon.

In the Add domain window, type * in the Fully Qualified Domain Name (FQDN) field, and click Save.

W 0 N Ok WD
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10. Click Next.

11. In the Source Server screen, click the Add icon.

12. In the Select a Server window, select the Exchange server, click Add, and click OK.

13. Click Finish.

14. In the left pane of the EAC, click servers, select the name of the Exchange server, and click Edit.

15. Click Outlook Anywhere, and enter the appropriate FQDN of the Client Access Server for the external and internal
hostname field. For example, exchangeserver.test.local

16. As the authentication method, choose NTLM, and click Save.

17. Click Virtual Directories, and then click the Configure external access domain icon.

18. In the Select the Client Access servers to use with the external URL window, click the Add icon.

19. Select the Exchange server, and click Add. Click OK.

20. Enter the FODN of the Exchange server in the Enter the domain field, and click Save.

21. Log into the Active Directory server using administrator credentials, and complete the following steps:
a. Open Server Manager, then click Tools>DNS.

b. In the left pane of DNS Manager, expand the Active Directory server name—>Forward Lookup Zones—>test.
local.

c. Inthe right pane, verify or create the DNS records as presented below.

name

exchangeserver.domain.

Mail Exchanger (MX) Leave blank domain.com com
Alias (CNAME) Autodiscover Autodiscover.domain.com :2trzrf]1angeserver.doma|n.
Alias (CNAME) Owa Owa.domain.com exchangeserver.domain.

com

22. Log into your Exchange server.

23. In the Exchange PowerShell, run the following commands, replacing $HostName with the host name (not FQDN) of
your Exchange server:

Set-EcpVirtualDirectory “$HostName\ECP (Default Web Site)” -InternalUrl ((Get-
EcpVirtualDirectory “S$HostName\ECP (Default Web Site)”) .ExternalUrl)

Set-WebServicesVirtualDirectory “S$HostName\EWS (Default Web Site)” -InternalUrl
((get-WebServicesVirtualDirectory “$HostName\EWS (Default Web Site)”).
ExternalUrl)

Set-ActiveSyncVirtualDirectory “$HostName\Microsoft-Server-ActiveSync (Default
Web Site)” -InternalUrl ((Get-ActiveSyncVirtualDirectory “$HostName\Microsoft-
Server-ActiveSync (Default Web Site)”) .ExternalUrl)

Set-OabVirtualDirectory “$HostName\OAB (Default Web Site)” -InternalUrl ((Get-
OabVirtualDirectory “$HostName\OAB (Default Web Site)”) .ExternalUrl)

Set-OwaVirtualDirectory “$HostName\OWA (Default Web Site)” -InternalUrl ((Get-
OwaVirtualDirectory “S$HostName\OWA (Default Web Site)”) .ExternalUrl)

Set-PowerShellVirtualDirectory “$HostName\PowerShell (Default Web Site)”
-InternalUrl ((Get-PowerShellVirtualDirectory “$HostName\PowerShell (Default Web
Site)”) .ExternalUrl)
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Get-0OfflineAddressBook | Set-OfflineAddressBook -GlobalWebDistributionEnabled $True
-VirtualDirectories $Null

Get-OutlookAnywhere | Set-OutlookAnywhere -ExternalHostname mail.ives.
lan -InternalHostname mail.ives.lan -ExternalClientsRequireSsl S$true
-InternalClientsRequireSsl S$true -DefaultAuthenticationMethod NTLM

24. Create a folder at the root of C: on the Exchange server, and share it to Everyone with read/write permissions.
25. Log into the Exchange admin center, and navigate to Servers->certificates.

26. In the drop-down menu, choose the Exchange server, and to create a new certificate, click the plus sign.

27. Choose Create a request for a certificate from a certification authority, and click Next.

28. Name the certificate, and click Next.

29. Do not request a wildcard certificate, and click Next.

30. Click Browse, choose the Exchange server, and click OK. Click Next.

31. Leave defaults, and click Next.

32. Leave defaults, and click Next.

33. Enter your organization information, and click Next.

34. Enter the path to the share you created on the Exchange server, and click Finish. Example: \\exchange\share\
myrequest.REQ

35. Log into the AD server, and open Internet Explorer.

36. Browse to localhost/CertSrv

37. Click Request a certificate.

38. Choose advanced certificate request.

39. Choose Submit a certificate request by using a base-64-endcoded CMC...

40. Open Windows Explorer, and navigate to the share folder on the Exchange server where the certificate request
is stored.

41. Open the certificate with Notepad, and copy the content between BEGIN NEW CERTIFICATE REQUEST and END
NEW CERTIFICATE REQUEST.

42. Paste the copied content into the Saved Request window.

43. Choose Web Server in the Certificate Template drop-down menu, and click Submit.
44. Choose Base 64 encoded, and download the certificate.

45. Copy the new certificate into the share folder on the Exchange server.

46. Log into the Exchange server and open the Exchange Admin Center.

47. Go to Servers>Certificates, and highlight the certificate you began before (it should read “Pending request” in the
status column).

48. On the right side, click Complete.

49. Enter the path to the certificate, including the certificate name, and click OK.
Example: \\exchange\share\certnew.CER

50. Verify that the status has changed to Valid.
51. Edit the new entry, and click Edit.
52. Go to Services, check SMTP and IIS, and click Save.

53. On the warning message, click Yes.
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54. Run the following steps on the Exchange and AD servers:
Click Start, and type MMC

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

o 9

Choose Local computer, and click Finish.

Click OK.

Expand Certificates> Trusted Root Certificate Authorities=>Certificates.
Click Action>All Tasks=>Import.

Click Next.

j.- Browse to the share folder on the Exchange server, and choose the new certificate you created. Click Next.
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k. Leave defaults, and click Next.
| Click Finish.
m. On the Import was successful message, click OK.

55. Log into the Exchange server, and open the Exchange admin center.

56. Navigate to Servers>Databases.

57. On the MB server, restart the Microsoft Exchange Information Store service.

58. Using the Edit button, disable the maintenance schedule, and enable circular logging for each mailbox database.

59. Dismount and remount the databases.

60. Open the Exchange Management shell, and type the following to move the paths of the default mailbox:
Move-Databasepath “DatabaseName” -EdbFilepath “E:\Newlocation\DBname.edb”
-LogFolderpath “F:\Newlocation”

61. When prompted, type A, and press Enter.

62. Open Exchange Management Shell, and type the following:

Get-OutlookAnywhere |Set-OutlookAnywhere -ExternalHostname exchange.domain.com
-DefaultAuthenticationMethod NTLM -ExternalClientsRequireSsl S$true

Configuring the Microsoft SQL Server 2014 server

For the legacy environment, we created large dedicated LUNs on the Dell EqualLogic PS6110 for the SQL database,
logs, and backup. For the upgraded environment, we added a 55GB virtual disk for the database, a 30GB virtual disk for
logs, and a 42GB virtual disk for backup to the SQL VM using the default Nutanix storage pool.

Installing SQL Server 2014 with Service Pack 1

1. Prior to installing, add the .NET Framework 3.5 feature to the server.
2. Mount the installation SQL Server 2014 DVD.

Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2014 DVD, and double-
click it.

w

In the left pane, click Installation.

Click New SQL Server stand-alone installation or add features to an existing installation.
Select Enter the product key, and enter the product key. Click Next.

Click to accept the license terms, and click Next.

Click Use Microsoft Update to check for updates, and click Next.
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To install the setup support files, click Install.
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10. If there are no failures displayed, click Next.
11. At the Setup Role screen, choose SQL Server Feature Installation, and click Next.

12. At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for Search,
Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and Management Tools —
Complete. Click Next.

13. At the Installation Rules screen, after the check completes, click Next.
14. At the Instance configuration screen, leave the default selection of default instance, and click Next.

15. At the Server Configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose NT
Service\MSSQLSERVER for SQL Server Database Engine. Change the Startup Type to Automatic. Click Next.

16. At the Database Engine Configuration screen, select the authentication method you prefer. For our testing purposes,
we selected Mixed Mode.

17. Enter and confirm a password for the system administrator account.

18. Click Add Current user. This may take several seconds.

19. Click Next.

20. At the Error and usage reporting screen, click Next.

21. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click Next.
22. At the Ready to Install screen, click Install.

23. After installation completes, click Close.

24. Run through the installation again, creating a new installation of SQL with the same settings.

25. Close the installation window.

Generating the DVD Store 2 data
We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the parameters for

our 40GB database and the Microsoft SQL Server 2014 platform. We ran the Install.pl script on a utility system running
Linux®. The Install.pl script also generated the database schema.

After processing the data generation, we transferred the data files and schema creation files to a Windows-based system
running SQL Server 2014. We built the 40GB database in SQL Server 2014, then performed a full backup, storing the
backup file on the SQL backup LUN for quick access. We used that backup file to restore the server between test runs.

The only modifications we made to the schema creation scripts were the specified file sizes for our database. We
explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the output of the
test. Apart from this file-size modification, we created and loaded the database schema according to the DVD Store
documentation. Specifically, we followed these steps:

1. Using database creation scripts in the DS2 download, generate the data, and create the database and file structure.

Make size modifications specific to the 40GB database, and make the appropriate changes to drive letters.

2. Transfer the files from a Linux data-generation system to a Windows system running SQL Server.

3. Create database tables, stored procedures, and objects using the provided DVD Store scripts.

4. To prevent excess logging, set the database recovery model to bulk-logged.

5. Load the generated data into the database. For data loading, use the import wizard in SQL Server Management
Studio. Where necessary, retain options from the original scripts, such as Enable Identity Insert.

6. Create indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.

Update statistics on each table according to database-creation scripts, which sample 18 percent of the table data.
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8. To create a ds2user SQL Server login on the SQL Server instance, use the following Transact-SQL (T-SQL) script:
USE [master]
GO
CREATE LOGIN [ds2user] WITH PASSWORD=N’"',
DEFAULT DATABASE=[master],
DEFAULT LANGUAGE=[us_english],
CHECK EXPIRATION=OFF,
CHECK_POLICY=OFF
GO
9. Set the database recovery model back to full.
10. Using SQL Server Management Studio, create the necessary full text index.
11. Create a database user, and map this user to the SQL Server login.

12. Perform a full backup of the database. This backup allows a restore of the database to a pristine state relatively
quickly between tests.

The figure below shows our initial file size modifications.

Filegroup Initial size (MB)

primary PRIMARY 3
cust1 DS_CUST_FG 6,144
cust? DS_CUST_FG 6,144
cust3 DS_CUST_FG 6,144
cust4 DS_CUST_FG 6,144
ind1 DS_IND_FG 3,280
ind2 DS_IND_FG 3,280
ind3 DS_IND_FG 3,280
ind3 DS_IND_FG 3,280
ds_misc DS_MISC_FG 200
orders1 DS_ORDERS 3,072
orders2 DS_ORDERS 3,072
orders3 DS_ORDERS 3,072
orders4 DS_ORDERS 3,072
Log files

ds_log N/A 25,375

Upgraded Dell XC730xd-12 Nutanix environment

We used the following steps to configure the Dell XC730xd-12 environment with Nutanix Acropolis. For the backing
storage, we used the default storage pool created from each host’s onboard SSDs and HDDs. For the initial testing, we
created a three-node Nutanix cluster. For the scaled environment, we used the Prism web console to expand the cluster
and automatically add the additional storage resources to the default pool. Once the virtual infrastructure was in place,
we used the same steps from the legacy environment to create VMs identical to each server role.
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Imaging bare metal nodes
A workstation machine is required to host the Nutanix Foundation VM during the imaging process.

1. In a browser, navigate to the Foundation download page in the Nutanix support portal (support.nutanix.com), and
download the latest Foundation_VM_QOVF-version#.tar file.

2. Navigate to the download location, and extract the archive with your environment’s preferred method.
3. Navigate to www.virtualbox.org, download Oracle VM VirtualBox, and install it to your workstation.

4. In your home directory, create a new folder called VirtualBox VMs.

5. Copy the .ovf and .vmdk files from the tar archive to the folder created in step 4.

6. Launch Oracle VM VirtualBox.

7. Click File, and select Import Appliance.

8. Navigate to the directory containing the Foundation VM .ovf file, select it, and click Next.

9. Click Import.

10. From the left column, select the Foundation VM, and click Start.
11. Boot the VM, and log into the nutanix account with the password nutanix\4u.

12. To determine whether the Foundation VM was assigned an IP address via DHCP or not, open Terminal, and run
ifconfig. If it was not, perform the following:

a. On the desktop, double-click set_foundation_ip_address.
b. Select Run in Terminal.

c. Select Device configuration.

d. Select the appropriate network device.

e. Uncheck Use DHCP, provide appropriate addresses to the Static IP, Netmask, Default gateway IP, and Primary
DNS Server fields, and select OK.

f.  Select Save.
g. Select Save&Quit.
13. Copy nutanix_installer_package-version#.tar.gz to the /home/nutanix/foundation/nos folder.

14. Navigate to the Nutanix support website, download the latest Acropolis ISO image, and copy the Acropolis ISO
image (we used version 20150921) into the /home/nutanix/foundation/isos/hypervisor/kvm folder.

15. On the Foundation VM desktop, double-click the Nutanix Foundation icon.

16. In the top section of the Global Configuration screen, provide appropriate values for the IPMI, hypervisor, and
Controller VM in the required fields. Additionally, set the CVYM memory as appropriate for your environment, though
Default is usually recommended.

17. Click Next.

18. If the page doesn’t automatically discover your nodes, select Add Blocks. In the dialog box, provide the correct
number of blocks and number of nodes per block. For the XC730xd nodes, we used one node per block.

19. If you added the nodes with the Add Blocks dialog, manually enter the IPMI MAC addresses, IPMI IP addresses,
hypervisor IP addresses, CVM IP addresses, and hypervisor hostnames.

20. Click Next.
21. Specify the Acropolis Base Software package and Acropolis hypervisor image, and click Next.
22. Click Create New Cluster.

23. In the Cluster creation section, provide a name for the cluster, a virtual cluster IP address, CVYM DNS servers, CVM
NTP servers, hypervisor NTP servers, and the max redundancy factor.

24. In the Post Image Testing section, check the boxes for Diagnostics and NCC if desired.

25. In Assigned to ClusterName, to choose all of the nodes for configuration, click Select All.
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26. Verify that your settings are correct. At the top of the page, click Run Installation.
27. To continue, click Proceed when the pop-up appears.
28. When the new buttons appear at the top right, click the Configure IPMI button.

29. When the IPMI configuration process completes and the page is still showing the cluster configuration, click Image
Nodes at the top of the page.

30. To continue, click Proceed when the pop-up appears.

31. When imaging completes, open the cluster IP address in a browser to access the Prism Central interface.
32. Log in as admin/admin, and then create a new password for the cluster admin account.

33. Agree to the EULA conditions, provide your name, company, and job title, and click Accept.

34. If desired, enable Pulse when prompted.

Upgrading the cluster

Log into the Prism web console.

In the upper right-hand corner of the Home page, click the cogwheel, and click Upgrade Software.
Select the desired component to upgrade. For example, select Acropolis.

If there is an upgrade available, click Download.

After the download finishes, click Upgrade>Upgrade Now.
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After the upgrade finishes, complete steps 3 through 5 for the remaining upgrades available for each component.

Creating the VM networks

1. In the upper right-hand corner of the Prism web console Home page, click the cogwheel, and click
Network Configuration.
Click + Create Network.
Enter a name and a VLAN ID for the new network, and click Save.

Complete steps 2 and 3 for every desired network. For our testing, we used separate VLANs for each Exchange and
AD environment to simplify our networking configuration after cloning.

Adding the necessary ISO images

We used the following steps to upload the virtio drivers for Windows and the Windows Server 2012 R2 ISO. We
uploaded each image to our client desktop for easy upload into the Nutanix image service.

1. In the upper right-hand corner of the Prism web console Home page, click the cogwheel, and click
Image Configuration.

Click + Upload Image.

Enter a name for the ISO image.

Select the default container for storage.

Select upload file, and click Choose File.

Browse to the client desktop, and select the desired file.
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Complete steps 2 through 6 for the remaining files.
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Creating the VMs

We created three gold-image VMs for each of the workloads: SQL, Exchange, and AD with lometer. We then used
these gold images to clone the three workloads multiple times until we reached the number of VMs that kept latency
under 20ms—a total of eight sets of the legacy environment for the three-node configuration and 10 sets for the four-
node environment.

Log into the Prism web console.
In the upper left-hand corner, click the Home dropdown menu, and select VM.
Select the Table view.
Click + Create New VM.
Use the following settings for each VM type:
a. Forthe SQL VM:

i. Enter a name for the VM.
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ii. Setthe vCPU count to four.

ii. Set Number of cores per vCPU to one.

iv. Setthe Memory to 32 GB.

v. Add a disk with the CDROM type, and select the virtio image from the image service.

vi. Add a disk with the CDROM type, and select the Windows Server 2012 R2 ISO image from the
image service.

vii. Add a 40GB virtual disk for the OS, a 55GB virtual disk for the database, a 30GB virtual disk for logs,
and a 42GB virtual disk for SQL backup.

viii. Using the default VLAN network, add a NIC.
b. Forthe Exchange VM:
i. Enter a name for the VM.
ii. Setthe vCPU count to four.
iii. Set Number of cores per vCPU to one.
iv. Setthe Memory to 16 GB.
v. Add a disk with the CDROM type, and select the virtio image from the image service.

vi. Add a disk with the CDROM type, and from the image service, select the Windows Server 2012 R2
ISO image.

vii. Add a 40GB virtual disk for the OS, a 120GB virtual disk for the database, a 10GB virtual disk for
logs, and a 120GB virtual disk for Exchange backup.

viii. Using the default VLAN network, add a NIC, and using the desired Exchange network VLAN, add
a NIC.

c. Forthe AD/lometer VM:
i.  Enter a name for the VM.
ii. Setthe vCPU count to four.
iii. Set Number of cores per vCPU to one.
iv. Setthe Memory to 2 GB.
v. Add a disk with the CDROM type, and select the virtio image from the image service.

vi. Add a disk with the CDROM type, and from the image service, select the Windows Server 2012 R2
ISO image.

vii. Add a 40GB virtual disk for the OS and a 120GB virtual disk for the lometer test file.

viii. Using the default VLAN network, add a NIC, and using the desired Exchange network VLAN, add
a NIC.
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Click Save.

Power on the VMs, and follow the steps outlined in the Legacy Environment section to install and configure
each workload.

8. After each configuration completes, clone all three VMs to the desired counts of eight times or ten times depending
on the node configuration.

9. Make the necessary virtual NIC adjustments on each clone to ensure that the Exchange and AD VMs are on the
correct VLAN for each configuration.

Configuring the clients and running the test

We ran all test clients on an appliance running a hypervisor. We used the following steps to configure each client VM.

Installing and configuring the Microsoft Exchange 2013 mail test clients and completing LoadGen

configuration on Exchange 2013

For our testing, we used one virtual client machine to run LoadGen 2013. To create the mail clients, we installed several
software components. We followed this process for each installation.

Installing Windows Server 2012 R2

Insert the installation media into the CD/DVD drive, and restart the appliance.

When prompted to boot from DVD, press any key.

When the installation screen appears, click My language is English (United States).
Leave language, time/currency format, and input method as default, and click Next.
Click Install now.

When the installation prompts you, enter the product key.

Select Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.
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Check | accept the license terms, and click Next.

9. Click Custom: Install Windows only (advanced).

10. Select Drive 0 Unallocated Space, and click Next.

11. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.

12. Log in with the password you set up previously.

To set up this appliance, we had to install several additional software components. The following subsections detail the
necessary installation processes.

Joining the domain

Set a static IP.

Select Start>Control Panel>Network Connections=>Local Area Connection.
Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.
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Select Use the following DNS server addresses, and enter the IP of the DNS server in the Preferred DNS server field.
Click OK.

Right-click My Computer, and select Properties.

o

Under the Computer Name tab, click Change.

In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and type
test.local

9. To start joining the domain, select OK.
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10.

11.

12.
13.

When the screen appears asking for a person qualified on the domain, type Administrator as the username and
Passwordl as the password.

At the Welcome pop-up window and the window warning that you must reset the computer for the changes to take
effect, click OK.

At the System Properties screen, click OK.

When a pop-up appears asking if you want to restart now, click Yes.

Installing Internet Information Services
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11.
12.

Click Start->Administrative Tools->Server Manager.

On the left pane, click Roles.

Click Add Roles.

Click the Application Server checkbox.

When the Add features required for Application Server? screen appears, click Add Required Features.
Click Next twice.

At the Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.
Click Add Required Support Role Services.

Click Next twice.

. At the Select Role Services page for Web Server (lIS), click the IS 6 Management Compatibility, ASP, and CGl

checkboxes, and click Next.
Click Install.
Click Close.

Importing the certificate and editing the hosts file
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Click Start, and type MMC

Click File->Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates> Trusted Root Certificate Authorities=> Certificates.
Click Action>All Tasks=>Import.

Click Next.

. Browse to the share folder on the Exchange appliance, and choose the new certificate you created. Click Next.

. Leave defaults, and click Next.

. Click Finish.

. On the Import was successful message, click OK.

. Open the Notepad program, and use File>Open to open the hosts file stored at C:\Windows\System32\drivers\etc.
. Add the IP and FQDN of the Exchange appliance.

. Save the file, and close Notepad.
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Preparing Load Generator

Log into the mail client.

Using all defaults, download and install Load Generator 2013.

Select Start>All Programs—>Microsoft Exchange—>Exchange Load Generator 2013.
When the Load Generator screen appears, select Start a new test.

Select Create a new test configuration, and click Continue.

Change the total length of simulation to one hour.
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In the Specify test settings screen, type Passwordl as the Directory Access Password and Mailbox Account Master
Password, and click Continue with recipient management.

8. Create 500 users in the Mailbox Database, and click Continue.
9. To accept defaults for Advanced recipient settings, click Continue.
10. In the Specify test user groups screen, select the plus sign to add a user group.

11. Change the Client Type to Outlook 2007 Cached, the action profile to Outlook_250, and the Mailbox size to 250 MB,
and click Continue.

12. In Remote configurations, leave the checkbox to enable distributing the workload unchecked, and click Continue.
13. Click Save the configuration file as, and name it testcfg.xml
14. Click Start the initialization phase (recommended before running the test).

15. After the database initializes, create a backup copy of the Exchange mailbox databases.

Configuring the database workload client

For our testing, we used a virtual client for the Microsoft SQL Server client. To create this client, we installed Windows
Server 2012 R2 and assigned a static IP address. We then copied over the DS2 driver executable and the associated
test scripts.

Running the tests

We ran all three tests simultaneously, using a script to start the final step of each of the following methodologies. If
necessary, run them manually.

Running the DVD Store test

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store outputs
an orders-per-minute (OPM) metric, which is a running average calculated through the test. In this report, we report the
last OPM reported by each client/target pair.

Each complete test cycle consisted of the following general steps:

Clean up prior outputs from the target system and the client driver system.

Drop the database from the target.

Restore the database on the target.

Shut down the target.

Reboot the system under test and the client system.

Wait for a ping response from the system under test and from the client system.

Let the system under test idle for 10 minutes.
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Start the DVD Store driver on the client. We used the following DVD Store parameters for testing:

ds2sglserverdriver.exe --target=<target IP> --ramp rate=10 --run time=60 --n_
threads=16 --db_size=40GB --think time=0.100 --detailed view=Y --warmup
time=10 --report rate=5 --csv_output=<drive path>
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Running the lometer test

1. Reboot the system under test.

2. Login, and let the system idle for 10 minutes.

3. Open lometer, and load the test file created earlier during setup.
4.

To kick off the lometer test, click Start.

Running Load Generator

Log into the mail client.

Select Start>All Programs—>Microsoft Exchange—>Exchange Load Generator 2013.
When the Load Generator screen appears, select Start a new test.

Select load a test configuration, and click Continue.

Leave the settings at their already determined settings, and click continue until you get to the last stage.
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After 10 minutes, click Skip initialization and start test.

Installing and configuring the management tools

We used the following steps to configure our management tool VMs for Dell Performance Analysis Collection Kit and
Dell OpenManage Essentials on the client appliances. Each VM started with a base install of Windows Server 2012 R2.

Installing and configuring Dell OpenManage Essentials

Download Dell OpenManage Essentials. Open the installation media.

2. Leave Dell OpenManage Essentials checked, and click Install.

w

At the Critical Prerequisites screen, click Install All Critical Prerequisites. When the warning dialog appears, to
continue installation of the critical prerequisites, click Yes.

At the next prerequisites screen, click Install Essentials. To install Essentials on a local database, click Yes.
Click Install Essentials.
Accept the license agreement for Dell OpenManage Essentials, and click Next.

Leave the Typical setup type selected, and click Next.
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Review the installation settings, and click Install.

9. When installation completes, leave Launch Dell OpenManage Essentials checked, and click Finish.
10. When Dell OpenManage Essentials launches, click the Manage tab.

11. Click the Discovery and Inventory subtab.

12. Click Add Discovery Range.

13. At the Discovery Range Configuration wizard, enter the IP address range for the first Dell appliance.
14. Click Add.

15. Click Next.

16. Leave the default Timeout and Retries ICMP parameters, and click Next.

17. Ensure the WS-Man discovery type is selected, and click Next.

18. Type the iDRAC User ID and Password for discovery (root / calvin). Ensure that Secure Mode and Trusted Site are
checked, and click Next.

19. Review the summary, and click Finish.
20. From the Manage tab, click the Discovery and Inventory subtab.
21. Click Add Discovery Range.

22. At the Discovery Range Configuration wizard, enter the IP address range for the second Dell appliance.
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23. Click Add.

24. Click Next.

25. Leave the default Timeout and Retries ICMP parameters, and click Next.
26. Ensure the WS-Man discovery type is selected, and click Next.

27. Type the iDRAC User ID and Password for discovery (root / calvin). Ensure that Secure Mode and Trusted Site are
checked, and click Next.

28. Review the summary, and click Finish.

Configuring Dell Performance Analysis Collection Kit (DPACK)

For this report, Dell gave us a DPACK account to download the tool and upload DPACK projects. We used the following
steps to perform DPACK data collection for each environment.

Download the Windows DPACK executable file to a Windows Server 2012 R2 client system.
Launch the executable file.
To agree to the license terms, click Yes.

Review the customer data, and click Yes.

o w D=

To automatically upload DPACK collections to the web account, select Establish a secure (HTTPS) connection to the
DPACK Web Service.

To generate a local IOKIT file, select Do not connect to the DPACK Web Service.
Click OK.

If DPACK has been configured previously, it will prompt you to decide if you want to use the previous setting.
Click No.

9. Select the local drive listed, and click Ignore Disk.
10. Click Add Remote Server.

11. Perform the following steps for each environment:

For the legacy environment:
a. Select Connect to a Windows server, and enter the IP of the first appliance.
b. Click Connect, and enter in the login credentials of the appliance.

c. Repeat steps a and b to add the remaining two appliances.

For the upgraded environment:

a. Select Connect to a Windows server, and enter the IP address of the first VM running on the Nutanix
environment.

b. Click Connect, and enter the login credentials of the VM.
c. Repeat steps a and b for every other VM running in the Nutanix environment.

Select Connect to a Linux server, and enter the IP address of the first Nutanix management VM in the
Nutanix environment.

e. Click Connect, and enter the login credentials of the VM.

f.  Repeat steps d and e for the other two or three Nutanix management VMs (depending on the number of
servers running in the test).

g. Select Connect to a Linux server, and enter the IP address of the first Nutanix hypervisor appliance in the
Nutanix environment.

h. Click Connect, and enter the login credentials of the VM.

i. Repeat steps g and h for the other two or three Nutanix hypervisors (depending on the number of servers
running in the test).
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12. After connecting all desired appliances, select any undesired disks from the list, and click Ignore Disk.
13. Change the capture duration to four hours.
14. Click Start capture.

Note: For our testing, we started the capture right before kicking off each test run. We cancelled the capture at the end
of roughly one hour, capturing data only when the appliances were under load.
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Appendix C — Our setup

Legacy environment

Our legacy environment consisted of three identical Dell PowerEdge R710 servers. Each contained 48 GB of RAM and
dual Intel Xeon E5520 processors. We installed Windows Server 2012 R2 with updates on them and configured each for
its individual workload purpose. For the database workload server, we installed SQL Server 2014 SP1 with updates and
configured a single SQL instance with a 40GB database for the DVD Store 2 server to target. For the mailbox workload
server, we installed Microsoft Exchange 2013 with updates. We then generated a typical 500-mailbox environment
using a Load Generator 2013 client. Finally, we installed lometer on the third server to simulate file server work and
configured the VM to act as the Active Directory server for the Exchange environment. We cabled all three servers to

a standard 1Gb Ethernet switch using the onboard NICs for client and management traffic. For information on our test
methodology, see Appendix B.

For the backing storage, we configured a Dell EqualLogic PS6110 array with 24 10K HDDs and 10Gb iSCSI connectivity.
We cabled each of the EqualLogic controllers to a 10Gb Dell Networking S4810 with redundant paths. We then installed
an Intel Ethernet Server Adapter X520 in each PowerEdge R710 and cabled both ports on each card to the S4810. We
configured each port for iSCSI traffic and multipath 17O using native Windows tools and the EqualLogic HIT Kit software.
We presented each server with individual LUNs on the EqualLogic PS6110 for their specific workloads: three LUNs for
the SQL database, logs, and backups to the database server; three LUNs for the Exchange mailbox database, logs, and
backups to the mailbox server; and one LUN for the lometer work file to the file server. See below for a detailed diagram
of our legacy environment test bed.

Our legacy environment test bed
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1Gb switch
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Upgraded environment

For our upgraded environment, we configured four identical Dell XC730xd-12 appliances. Each server contained 256 GB
of RAM and dual Intel Xeon E5-2680 v4 processors. We initially created a three-node cluster using Nutanix Foundation to
deploy Acropolis to the nodes and configure Prism. Once the three-node testing concluded, we expanded the cluster to
include the fourth node. We cabled each server's IPMI port to a Dell Networking N2024 1Gb switch. We then cabled two
10Gb ports per server to two Dell Networking S4048-ON switches for all client, VM, and storage traffic. The two S4048-
ON switches were stacked via two 40Gb ports for redundancy. Additionally, we cabled the N2024 switch to the S4048
stack via two 10Gb ports split between the two switches. We set up a generic server for our test clients and management
VMs and cabled it via a 1Gb onboard port to the N2024.

For the backing storage on the XC730xd-12 appliances, we allowed Acropolis to configure a default storage pool using
each server's onboard storage and Nutanix Distributed File system for VM storage. See below for a detailed diagram of
our upgraded environment test bed.

Our upgraded environment test bed
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Each server hosted a mix of database workload VMs, mailbox workload VMs, and file workload VMs, with each VM
matching the software configuration of the legacy servers. We allowed Nutanix to balance the test VMs, evenly spreading
24 VMs across three XC730xd-12 appliances for the initial configuration and 30 VMs across four nodes for the scaled
configuration. We resized the VMs' resources lower than the legacy environment servers to allow for maximum resource
utilization and workload consolidation because our test VMs were performing at the level of the legacy environment or
better. For each VM type, we used the following VM hardware settings:

RAM OS vDisk Data vDisk Log vDisk Backup vDisk
i decie (e]:) (GB) (GB) (GB) (e]:)
4 32 40 55 30 42

Database
Mailbox 4 16 40 120 10 120
File 4 2 40 120 N/A N/A
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Appendix D — DPACK data

The following screenshots of the DPACK reports show performance of the upgraded environment with three and four
nodes. The data from this hour-long test run serves as an example of the solution’s performance throughout testing,
specifically in regards to CPU utilization, input/output per second (IOPS), and storage latency.

CPU utilization

The upgraded environment with three nodes achieved a peak CPU utilization of 22.9 percent and averaged
approximately 16 percent. This leaves plenty of CPU for additional VMs or for existing VMs.
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With the addition of the fourth node, the environment CPU utilization peaked at 24.2 percent and averaged about 17
percent at a steady state. Overall, the infrastructure’s CPU in both cases remained underutilized due to the limitations of
our storage.
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IOPS
With the three-node configuration, the environment peaked at nearly 9,000 IOPS and averaged about 6,000 IOPS.
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However, with the addition of the fourth node, the environment achieved a peak of around 12,000 IOPS and averaged
approximately 8,000 IOPS over the course of the run. The results show scaling up to the fourth node adds IOPS nearly
perfectly with an overall increase of about 33 percent.
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Latency

We considered 20ms an acceptable threshold for latency during testing. In the three-node configuration, the upgraded
environment's latency peaked at a 19ms read and a 13ms write. Latency remained below the acceptable threshold during

the run.
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With the additional fourth node, the upgraded environment latency peaked at just over a 16ms read and a 12ms write.
Latency again remained below the acceptable threshold during the test run.
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The performance of the 7.2K HDDs limited the overall performance of the configuration. An additional set of VMs raised
the disk latency above the 20ms threshold. With upgraded disks, these servers could have potentially handled many
more VMs.
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Additional DPACK counters

DPACK also provides many other graphs showing metrics like memory utilization, network and storage throughput, I/O
size, and more. We did not use these graphs in our analysis. When you examine all the graphs together, the data they
provide can give you a clear picture of your current environment’s performance needs as well as potential bottlenecks
and limitations.
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This project was commissioned by Dell.

‘ Principled

Technologies®

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc.
specifically disclaims any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any
implied warranty of fitness for any particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that
Principled Technologies, Inc., its employees and its subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any
alleged error or defect in any testing procedure or result.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if
advised of the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in
connection with Principled Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.
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